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1 WELCOME 

RSV-S4-X enhances your data storage by combining advanced RAID1 features typically seen 

on high-end data systems with low cost/high capacity Serial ATA drives. By using industry 

standard SATA drives and Silicon Image Host Bus Adapters, you can achieve extraordinarily 

low costs while remaining assured that your data is protected against hardware failure. 

1.1 PRECAUTION 

Please read the safe precautions carefully before you using RSV-S4-X storage appliance. 

Ensure that you use the product correctly according to the procedure described in this guide. 

The following safety precautions are intended to remind you to operate the product safely and 

correctly.  Please read and ensure that you understand them before you proceed to the other 

sections of this guide. 

 Do not attempt to disassemble or alter any part of the product that is not describe in this 

guide. 

 Do not allow the product to come into contact with water or other liquids.  In the event 

that water or other liquids enter the interior, immediately unplug the product from the 

computer.  Continued use of the product may result in fire or electrical shock.  Please 

consult your product distributor or the closest support center. 

 Do not handle the product near a heat source or expose them to direct flame or heat. 

 Never place the product in close to equipment generating storage electromagnetic fields.  

Exposure to strong magnetic fields may cause malfunctions or corrupt data. 

 Can’t operate properly under Windows 3.x/ 95 / 98SE/ ME/ NT. 

 Hard disk drive is not including. 

                                                           
1 Redundant Array of Independent Devices, a method of combining drives to provide better protection and/or performance. 
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1.2 FEATURES 

1.2.1  DATA SECURITY 

The RSV-S4-X software driver includes support for monitoring to predict suspect drives. 

RSV-S4-X provides our highest commitment to data security through the use of RAID 

architecture to back up and protect data. RAID levels 1, 10, and 5 provide data security. RSV-

S4-X supports sophisticated sparing support so that hardware failure risk can be minimized 

by automatically regenerating the failed disk’s data on a backup disk. The RSV-S4-X software 

driver includes support for Self-Monitoring Analysis and Reporting Technology (S.M.A.R.T.2) 

to predict disk failures. Drives can be moved between controllers without losing data.  

1.2.2  DATA PERFORMANCE 

The RSV-S4-X can also increase storage throughput by combining the throughput of multiple 

drives into a single volume. RAID levels 1, 10, and 5 support this ability.  Furthermore, each 

volume can be tailored to provide the best performance for the data contained on that disk. 

1.2.3 DATA VERSATILITY 

The RSV-S4-X software driver also supports Contiguous and Concatenated drives for 

applications which do not require increased security or performance. 

1.3 EASE OF USE 

The RSV-S4-X utility offers an easy to use utility for creating and managing your storage. It 

also supports the latest SATA enhancements including SATA-II Port Multiplier support, and 

up to 3Gbit/sec transfer rates on controllers that support that speed. Creating and deleting 

volumes is also possible without requiring a restart of the operating system and rebuilds never 

require the data to be taken off-line. 

Drives can also be moved between controllers without losing the data. 

                                                           
2 Self Monitoring, Analysis and Reporting Testing. 
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1.4 SPECIFICATIONS 

 A single eSATA host port to 4 SATA 3.5-inch hard disks, with tool-less screws & door 

cover. 

 Power and host status LED, and devices status and activity LED. 

 Metal chassis (SECC) and plastic panel frame (ABS) design. 

 135 (W) x 180 (H) x 255 (D) mm, NW: 2.7 Kgs, GW: 3.1Kgs. 

 Design based on the Silicon Image SiI3726 Port-Multiplier with SiI3132R5 PCI-Express 

1X HBA. 

 Support Striped (RAID 0), Mirrored (RAID 1), Mirrored Striped (RAID 10), Parity RAID 

(RAID 5) modes, and   hot spare on Mirrored (RAID 1) and Parity RAID (RAID 5) modes. 

 Support Contiguous (Single Drive) & Concatenation (Combined Drives) modes. 

 150 watts, 100 & 240 Vac / 50~60Hz with FCC, CE requirement. 

 Single packing (color box with handle) and 4 in 1 outer box. 

1.5 SUPPORTED OPERATING SYSTEMS 

The following operating systems are supported by the RSV-S4-X software driver.  

 Windows 2000 

 Windows XP, 32/64-bit 

 Windows Server 2003, 32/64-bit 

 Windows Vista, 32/64-bit 

 Windows Server 2008, 32/64-bit 

 Windows 7, 32/64-bit 
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1.6 PRODUCT CONTENTS 

The following parts are content. 

 RSV-S4-X Port-Multiplier Box 

 SiI3132R5 PCI-Express 1X HBA 

 eSATA Cable 

 AC Cable 

 Tool-less Screw x 8 

 Setup and Installation Driver Repository CD 
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2 INTRODUCTION TO RAID 

2.1 RAID VOLUMES 

RAID technology allows one or more disks to be combined into a logical volume which 

provides greater performance and/or protection than standard disk drives. These volumes, 

also known as RAID Groups, appear like regular disk drives to the operating system and can 

be partitioned, formatted and used just like any other normal disk. The complexity of the RAID 

is hidden within the driver. 

There are several different methods of combining disks, each with its own advantages and 

disadvantages.  Each method is referred to as a RAID “level” such as RAID 1, or RAID 5.  The 

details of each level are summarized below and detailed in the following sections. 

RAID LEVEL CONFIGURED 

AS 

ADVANTAGES DISADVANTAGES 

0 Striped Excellent performance, low cost No data protection 

1 Mirrored Excellent data protection High cost 

10 Mirrored Striped 
High performance, excellent 
data protection. 

High cost. 

5 Parity RAID 
Good data protection, good 
value 

Some performance 
degradation for writes. 

Combination Concatenated 
Good performance, low cost, 
large Volume size 

No data protection 

Single Drive / 
Segment 

Contiguous Same as single disk Same as single disk 

2.2 SEGMENTING DISKS 

For increased versatility, the SATARAID5 software allows individual disks to be divided into 

smaller segments which can then be combined into different volumes.  As an example, if a 

user has one set of data that must be protected at all costs, another set of data which should 

be protected at reasonable cost and another set that doesn’t need any protection at all; the 

user can divide three disks into sections as shown in Figure 1.  The yellow regions define the 
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high security volume, the greem section is the middle security volume and the light blue 

shows the unprotected area.  

 

Figure 1:  Dividing Disks into Members 

2.3 RAID LEVELS 

2.3.1 DISK STRIPING (RAID 0) 

Striping is a performance-oriented, non-redundant data mapping technique. While Striping is 

discussed as a RAID Group type, it is does not provide any fault tolerance. With modern 

SATA and ATA bus mastering technology, multiple I/O operations can be performed in 

parallel, enhancing data throughput. Striping arrays use multiple disks to form a larger virtual 

disk. The figure below illustrates a three-disk stripe set. Stripe one is written to disk one, 

stripe two to disk two, and so forth. RAID 0 sets can be comprised of two, three, or four 

drives. If the sizes of the disk segments are different, the smallest disk segment will limit the 

overall size of the RAID Group. 

 
Stripe2
Stripe5
Stripe8
Stripe11

Stripe0 
Stripe3 
Stripe6 
Stripe9 

Stripe1
Stripe4
Stripe7
Stripe10  
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2.3.2 DISK MIRRORING (RAID 1) 

Disk mirroring creates an identical twin for a selected disk by having the data simultaneously 

written to two disks. This redundancy provides instantaneous protection from a single disk 

failure. If a read failure occurs on one drive, the system reads the data from the other drive.  

RAID 1 sets are comprised of two drives, and a third drive can be allocated as a spare in case 

one of the drives in the set fails. If the sizes of the disk segments are different, the smallest 

disk segment will limit the overall size of the RAID Group. 

Block 0
Block 1
Block 2
Block 3

Block 0
Block 1
Block 2
Block 3  

2.3.3 DISK MIRRORING AND STRIPING (RAID 10) 

RAID 10 combines the features of both RAID 0 and RAID 1. Performance is provided through 

the use of Striping (RAID 0), while adding the fault tolerance of Mirroring (RAID 1). The 

implementation of RAID 10 requires four drives. The drives are assigned as two sets of striped 

pairs.  

 

The data is written to RAID Group A, which is mirrored (RAID 1) and provides data 

redundancy. Alternating blocks of data are then striped across another RAID 1 mirrored set, 

shown as Set B in the figure above. This provides improved speed.  

Under certain circumstances, a RAID 10 set can sustain multiple simultaneous drive failures.  
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2.3.4 PARITY RAID (RAID 5) 

Parity or RAID 5 adds fault tolerance to Disk Striping by including parity information with the 

data. Parity RAID dedicates the equivalent of one disk for storing parity stripes. The data and 

parity information is arranged on the disk array so that parity is written to different disks. 

There are at least 3 members to a Parity RAID set. The following example illustrates how the 

parity is rotated from disk to disk. The following example illustrates how the parity is rotated 

from disk to disk.  

 

 

Parity RAID uses less capacity for protection and is the preferred method to reduce the cost 

per megabyte for larger installations. Mirroring requires 100% increase in capacity to protect 

the data whereas the above example using three hard drives only requires a 50% increase. 

The additional required capacity decreases as the number of disks in the group increases (i.e., 

33% for four drives or 25% for five drives).  

In exchange for low overhead necessary to implement protection, Parity RAID degrades 

performance for all write operations. The parity calculations for Parity RAID may result in write 

performance that is somewhat slower than the write performance to a single disk.  

2.3.5 CONCATENATION 

The Concatenated mode combines multiple disks or segments of disks into a single large 

volume. It does not provide any data protection or performance improvement but can be 

useful for utilizing leftover space on disks. Concatenation allows the segments that make up 

the volume to be of different sizes.  
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2.3.6 SINGLE DRIVE / SEGMENT 

The single drive is a virtual disk that can either be an entire disk drive or a segment of a single 

disk drive. Single drive is the “Contiguous” configuration option when creating RAID Groups 

(or sets) in the SATARAID5 software. 

2.4 RAID VOLUME STATUS 

A RAID volume can be in any one of the following statuses. 

STATUS MEANING 

Good All disks are currently functioning as normal. 

Reduced 

For RAID levels that provide data protection, one or more disks have 

failed but the data is still available via the RAID algorithms. The failed 

disk should be replaced as soon as possible to avoid loss of data. 

Rebuilding 

A failed disk drive has been replaced and the data is being regenerated 

on the replacement disk. When complete, the RAID Group will return to 

Good status. 

Resynchronizing 

An error has occurred and RAID algorithms be regenerated on this 

RAID Group. When complete, the RAID Group will return to Good 

status. 

Failed 

One or more disks have failed and RAID algorithms can no longer 

regenerate the data. The minimum number of failures required to reach 

this state depends on the RAID level: 

 RAID 0, Concatenated, Contiguous: Single disk failure. 

 RAID 1, 10, and 5: Two disk failure. 
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3 INSTALLATION 

3.1 COMPONENTS 

There are three separate steps that must be install or setup for RSV-S4-X to function. These 

components are the HARDWARE, SATA RAID5 HBA DRIVER, and SATARAID5 Utility. The 

steps on how to setup these packages is described in the following sections. 

3.2 INSTALLING HARDWARE 

Follow the descriptions below, and step by step to complete the installation. 

 Turn off your host computer. 

 Install the SiI3132 PCI-Express 1X SATA RAID5 HBA into a PCI-Express slot (1X ~ 16X), 

than connect one end of the eSATA cable to the eSATA connector on the Sil3132 PCI-

Express 1X SATA RAID5 HBA. 

 Connect the other end to the eSATA connecter on RSV-S4-X. 

 If hard disk drives are not installed in RSV-S4-X, insert the drives most of the way into 

bay 1 to 4 in order (from the bottom to top); gently insert the drive until the drive is fully 

inserted, and twist the tool-less screw shut to seat the drive securely. 

 Switch the VAC to the correct position (For example, 115 for Japan, and 230 for UK) 

attach one end of the AC power cord to RSV-S4-X and the other end to the proper AC 

receptacle. 

 Turn on RSV-S4-X, than turn on the host computer. 

3.3 INSTALLING ON WINDOWS 2000 

3.3.1 INSTALLING SATA RAID HOST BUS ADAPTER 

Follow the descriptions below, and step by step to complete the setup. 
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 Insert the Setup and Installation Repository CD in the CD-ROM drive. 

 When start the Windows O/S, new hardware will be found, click Next>. 

 

 Select Search for a suitable driver for my device (recommended), than click Next>. 

 

 Select Specify a location, than click Next>. 
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 Click Browse… to select to driver path, than click OK. 

 

 Click Next> to install the Silicon Image Sil3132 SoftRaid 5 Controller driver. 

 

 Click Yes to pass the Microsoft digital signature and continue the installation. 
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 When the Silicon Image Sil3132 SoftRaid 5 Controller installation has completed, click 

Finish, and begin to the Silicon Image’s Pseudo Processor Device driver installation. 

 

 Windows will find the Silicon Image’s Pseudo Processor Device hardware, click Next>. 
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 Select Search for a suitable driver for my device (recommended), than click Next>. 

 

 Select Specify a location, than click Next>. 
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 Click Browse… to select to driver path, than click OK. 

 

 Click Next> to install the Silicon Image’s Pseudo Processor Device driver. 

 

 When the Silicon Image’s Pseudo Processor Device installation has completed, click 

Finish. 
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3.3.2 INSTALLING SATARAID5 UTILITY 

Follow the descriptions below, and step by step to complete the installation. 

 Open the Setup and Installation Repository CD and select the SATARAID5 Array 

Manager software from the Utility folder. 

 Double-click the 3132-W-I32-R.exe file. 

 

 Click Next> to begin setup. 

 

 Select I Agree, than click Next>. 
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 Select Place shortcut on Desktop, than click Next> to create a shortcut on the desktop. 

 

 Click Next> to use the default installation folder. 
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 Click Next> to begin the installation. 

 

 When SATARAID5 installation has completed, click Close to exit. 
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 Select I agree the terms in the license agreement, than click Next> to begin the Java 

platform installation. 

 

 

 Select Typical, than click Next>. 

 

 When Java platform installation has completed, click Finish to exit. 
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 Select Start > Programs > Silicon Image > SATARaid5Manager to start the Array 

Manager software. 

3.3.3 DISK DRIVE MODE SETUP 

Please refer to the chapter 4.  

3.3.4 ALLOCATING PARTITION 

Before creating any partitions, RAID groups must first be created using the 

SATARaid5Manager utility. Once the sets have been created, allow the system to load 

Windows.  

 Right-click on My Computer icon and select Manage from the pop-up menu. 
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 Select Disk Management under Storage to view the disk drives. 

 

 When Write Signature and Upgrade Disk Wizard appears, click Next>. 
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 Select the new disk to write a signature, than click Next>.  

 

 Do not click any disk to upgrade to dynamic disk, than click Next>. 
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 When the Write Signature and Upgrade Disk Wizard has completed, click Finish. 

 

 Right-click on the Unallocated partition and select Create Partition… from the pop-up 

menu. 

 

 Click Next> to create a partition on a basic disk. 
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 Select the partition type you want to create, than click Next>. 

 

 Specify the partition size you want to create, than click Next>. 
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 Assign the drive letter or path you want to create, than click Next>. 

 

 Click Format this partition with the following settings and Perform a Quick Format, 

setup the File system to use, Allocation unit size, Volume label, than click Next>. 

 

 When the Create Partition Wizard has completed, click Finish. 
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The status of the newly created partition in the Disk Management window should change to 

Formatting and the percentage complete will be displayed. Depending upon the size of the 

partition, the format process may take several minutes. When complete, the status will 

change to “Healthy” and the name and drive letter will be updated. Once the disk reports 

Healthy, it appears in the listing in System Listing section with all of its pertinent information 

as well. 

 

Repeat the above procedure as needed for any other partitions. Close the Data 

Management window by clicking on the small boxed “X” in the top right corner of the 
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window. Click on the “My Computer” icon on the Desktop. The new drives will be visible 

and properly named. The new disks are available for use. 

 

3.4 INSTALLING ON WINDOWS XP (32/64-BIT) 

3.4.1  INSTALLING SATA RAID HOST BUS ADAPTER 

Follow the descriptions below, and step by step to complete the setup. 

 Insert the Setup and Installation Repository CD in the CD-ROM drive. 

 When start the Windows O/S, new hardware will be found; Select No, not this time, than 

click Next>. 
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 Select Install from a list or specific location (Advanced), than click Next>. 

 

 Select Search for the best driver in there location, Include this location in the search, 

and click Browse to select the driver path, than click Next>. 



4 Bay SATA to eSATA 3.5” HDD RAID Storage System RSV-S4-X                                              User Manual 
 
 

 34

 

 

 When the installation has completed, click Finish. 
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3.4.2  INSTALLING SATARAID5 UTILITY 

Follow the descriptions below, and step by step to complete the installation. 

 Open the Setup and Installation Repository CD and select the SATARAID5 Array 

Manager software from the Utility folder. 

 Double-click the utility file. 

 

 

 Click Next> to begin setup. 
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 Select I Agree, than click Next>. 

 

 Select Place shortcut on Desktop, than click Next> to create a shortcut on the desktop. 
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 Click Next> to use the default installation folder. 

 

 Click Next> to begin the installation. 
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 When SATARAID5 installation has completed, click Close to exit. 

 

 Select I accept the terms in the license agreement, than click Next> to begin the Java 

platform installation. 

 

 Select Typical, than click Next>. 
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 When Java platform installation has completed, click Finish to exit. 

 

 Select Start > All Programs > Silicon Image > SATARaid5Manager to start the Array 

Manager software. 

3.4.3  DISK DRIVE MODE SETUP 

Please refer to the chapter 4.  

3.4.4  ALLOCATING PARTITIONS ON WINDOWS XP 32-BIT 

Before creating any partitions, RAID groups must first be created using the 

SATARaid5Manager utility. Once the sets have been created, allow the system to load 

Windows. 
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 Right-click on My Computer icon and select Manage from the pop-up menu. 

 

 Select Disk Management under Storage to view the disk drives. 

 

 When Initialize and Convert Disk Wizard appears, click Next>. 
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 Select the new disk to initialize, than click Next>.  

 

 Do not click any disk to convert, than click Next>. 
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 When the Initialize and Convert Disk Wizard has completed, click Finish. 

 

 Right-click on the Unallocated partition and select New Partition… from the pop-up 

menu. 

 

 Click Next> to create a partition on a basic disk. 
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 Select the partition type you want to create, than click Next>. 

 

 Specify the partition size you want to create, than click Next>. 
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 Assign the drive letter or path you want to create, than click Next>. 

 

 Click Format this partition with the following settings and Perform a quick format, 

setup the File system, Allocation unit size, Volume label, than click Next>. 

 

 When the New Partition Wizard has completed, click Finish. 
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The status of the newly created partition in the Disk Management window should change to 

Formatting and the percentage complete will be displayed. Depending upon the size of the 

partition, the format process may take several minutes. When complete, the status will 

change to “Healthy” and the name and drive letter will be updated. Once the disk reports 

Healthy, it appears in the listing in System Listing section with all of its pertinent information 

as well. 

 

Repeat the above procedure as needed for any other partitions. Close the Data 

Management window by clicking on the small boxed “X” in the top right corner of the 
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window. Click on the “My Computer” icon on the Desktop. The new drives will be visible 

and properly named. The new disks are available for use. 

 

3.4.5  ALLOCATING PARTITIONS ON WINDOWS XP 64-BIT 

Before creating any partitions, RAID groups must first be created using the 

SATARaid5Manager utility. Once the sets have been created, allow the system to load 

Windows. 

 Right-click on My Computer icon and select Manage from the pop-up menu. 



4 Bay SATA to eSATA 3.5” HDD RAID Storage System RSV-S4-X                                        User Manual 

 

 47

 

 Select Disk Management under Storage to view the disk drives. 

 

 When Initialize and Convert Disk Wizard appears, click Next>. 
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 Select the new disk to initialize, than click Next>.  

 

 Do not click any disk to convert, than click Next>. 
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 When the Initialize and Convert Disk Wizard has completed, click Finish. 

 

 Windows 64-bit system supports GPT disk which supports disk volume greater than 2TB. 
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 Right-click on the Basic disk and select Convert to GPT disk from the pop-up menu. 

 

 Right-click on the Unallocated partition and select New Partition… from the pop-up 

menu. 



4 Bay SATA to eSATA 3.5” HDD RAID Storage System RSV-S4-X                                        User Manual 

 

 51

 

 Click Next> to create a partition on a basic disk. 

 

 Select the partition to create, than click Next>. 
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 Specify the partition size you want to create, than click Next>. 

 

 Assign the drive letter or path you want to create, than click Next>. 
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 Click Format this partition with the following settings and Perform a quick format, 

setup the File system, Allocation unit size, Volume label, than click Next>. 

 

 When the New Partition Wizard has completed, click Finish. 
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The status of the newly created partition in the Disk Management window should change to 

Formatting and the percentage complete will be displayed. Depending upon the size of the 

partition, the format process may take several minutes. When complete, the status will 

change to “Healthy” and the name and drive letter will be updated. Once the disk reports 

Healthy, it appears in the listing in System Listing section with all of its pertinent information 

as well. 

 

Repeat the above procedure as needed for any other partitions. Close the Data 

Management window by clicking on the small boxed “X” in the top right corner of the 
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window. Click on the “My Computer” icon on the Desktop. The new drives will be visible 

and properly named. The new disks are available for use. 

 

3.5 INSTALLING ON WINDOWS SERVER 2003 

(32/64-BIT) 

3.5.1  INSTALLING SATA RAID HOST BUS ADAPTER 

Follow the descriptions below, and step by step to complete the setup. 

 Insert the Setup and Installation Repository CD in the CD-ROM drive. 

 When start the Windows O/S, new hardware will be found; Select No, not this time, than 

click Next>. 
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 Select Install from a list or specific location (Advanced), than click Next>. 

 

 Select Search for the best driver in there location, Include this location in the search, 

and click Browse to select the driver path, than click Next>. 
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 When the installation has completed, click Finish. 
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3.5.2  INSTALLING SATARAID5 UTILITY 

Follow the descriptions below, and step by step to complete the installation. 

 Open the Setup and Installation Repository CD and select the SATARAID5 Array 

Manager software from the Utility folder. 

 Double-click the utility file. 

 

 

 Click Next> to begin setup. 



4 Bay SATA to eSATA 3.5” HDD RAID Storage System RSV-S4-X                                        User Manual 

 

 59

 

 Select I Agree, than click Next>. 

 

 Select Place shortcut on Desktop, than click Next> to create a shortcut on the desktop. 
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 Click Next> to use the default installation folder. 

 

 Click Next> to begin the installation. 

 

 When SATARAID5 installation has completed, click Close to exit. 
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 Select I accept the terms in the license agreement, than click Next> to begin the Java 

platform installation. 

 

 Select Typical, than click Next>. 
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 When Java platform installation has completed, click Finish to exit. 

 

 Select Start > All Programs > Silicon Image > SATARaid5Manager to start the Array 

Manager software. 

3.5.3  DISK DRIVE MODE SETUP 

Please refer to the chapter 4.  

3.5.4  ALLOCATING PARTITIONS 

Before creating any partitions, RAID groups must first be created using the 

SATARaid5Manager utility. Once the sets have been created, allow the system to load 

Windows. 
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 Right-click on My Computer icon and select Manage from the pop-up menu. 

 

 Select Disk Management under Storage to view the disk drives. 

 

 When Initialize and Convert Disk Wizard appears, click Next>. 
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 Select the new disk to initialize, than click Next>.  

 

 Do not click any disk to convert, than click Next>. 
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 When the Initialize and Convert Disk Wizard has completed, click Finish. 

 

 Windows Server 2003 SP1 or later system supports GPT disk which supports disk 

volume greater than 2TB. 
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 Right-click on the Basic disk and select Convert to GPT disk from the pop-up menu. 

 

 Right-click on the Unallocated partition and select New Partition… from the pop-up 

menu. 
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 Click Next> to create a partition on a basic disk. 

 

 Select the partition to create, than click Next>. 
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 Specify the partition size you want to create, than click Next>. 

 

 Assign the drive letter or path you want to create, than click Next>. 



4 Bay SATA to eSATA 3.5” HDD RAID Storage System RSV-S4-X                                        User Manual 

 

 69

 

 Click Format this partition with the following settings and Perform a quick format, 

setup the File system, Allocation unit size, Volume label, than click Next>. 

 

 When the New Partition Wizard has completed, click Finish. 
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The status of the newly created partition in the Disk Management window should change to 

Formatting and the percentage complete will be displayed. Depending upon the size of the 

partition, the format process may take several minutes. When complete, the status will 

change to “Healthy” and the name and drive letter will be updated. Once the disk reports 

Healthy, it appears in the listing in System Listing section with all of its pertinent information 

as well. 

 

Repeat the above procedure as needed for any other partitions. Close the Data 

Management window by clicking on the small boxed “X” in the top right corner of the 
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window. Click on the “My Computer” icon on the Desktop. The new drives will be visible 

and properly named. The new disks are available for use. 

 

3.6 INSTALLING ON WINDOWS VISTA (32/64-BIT) 

3.6.1  INSTALLING SATA RAID HOST BUS ADAPTER 

Follow the descriptions below, and step by step to complete the setup. 

 Insert the Setup and Installation Repository CD in the CD-ROM drive. 

 When start the Windows O/S, new hardware will be found; Select Locat and install 

driver software (recommended). 
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 Insert the disc that came with your RAID Controller, than click Next. 

 

 When the installation has completed, click Close. 
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3.6.2  INSTALLING SATARAID5 UTILITY 

Follow the descriptions below, and step by step to complete the installation. 

 Open the Setup and Installation Repository CD and select the SATARAID5 Array 

Manager software from the Utility folder. 

 Double-click the utility file. 

 

 

 Click Next> to begin setup. 
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 Select I Agree, than click Next>. 

 

 Select Place shortcut on Desktop, than click Next> to create a shortcut on the desktop. 
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 Click Next> to use the default installation folder. 

 

 Click Next> to begin the installation. 
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 When SATARAID5 installation has completed, click Close to exit. 

 

 Select I accept the terms in the license agreement, than click Next> to begin the Java 

platform installation. 

 

 Select Typical, than click Next>. 
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 When Java platform installation has completed, click Finish to exit. 

 

 Select Start > All Programs > Silicon Image > SATARaid5Manager to start the Array 

Manager software. 

3.6.3  DISK DRIVE MODE SETUP 

Please refer to the chapter 4.  

3.6.4  ALLOCATING PARTITIONS 

Before creating any partitions, RAID groups must first be created using the 

SATARaid5Manager utility. Once the sets have been created, allow the system to load 

Windows. 
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 Right-click on My Computer icon and select Manage from the pop-up menu. 

 

 Select Disk Management under Storage to view the disk drives. 

 

 When Initialize Disk Wizard appears, select Disk 1 and GPT (GUID Partition Table), 

than click OK. 
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 Windows Vista system supports GPT disk which supports disk volume greater than 2TB. 

 

 Right-click on the Unallocated partition and select New Single Volume… from the pop-

up menu. 
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 Click Next> to create the partition. 

 

 Specify the partition size you want to create, than click Next>. 
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 Assign the drive letter or path you want to create, than click Next>. 

 

 

 Click Format this partition with the following settings and Perform a quick format, 

setup the File system, Allocation unit size, Volume label, than click Next>. 



4 Bay SATA to eSATA 3.5” HDD RAID Storage System RSV-S4-X                                              User Manual 
 
 

 82

 

 When the New Partition Wizard has completed, click Finish. 

 

The status of the newly created partition in the Disk Management window should change to 

Formatting and the percentage complete will be displayed. Depending upon the size of the 

partition, the format process may take several minutes. When complete, the status will 

change to “Healthy” and the name and drive letter will be updated. Once the disk reports 

Healthy, it appears in the listing in System Listing section with all of its pertinent information 

as well. 
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Repeat the above procedure as needed for any other partitions. Close the Data 

Management window by clicking on the small boxed “X” in the top right corner of the 

window. Click on the “My Computer” icon on the Desktop. The new drives will be visible 

and properly named. The new disks are available for use. 
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4 SATA RAID5 ARRAY MANAGER 

4.1 OVERVIEW 

The SATARAID5 Array Manager is the Graphical User Interfaces (GUI) which allows you to 

create and manage RAID volumes. The Manager initially shows two windows as seen below. 

 

The RAID Groups window identifies SATA host adapters and configured RAID groups. For 

systems with more than one Silicon Image Host Bus Adapter installed, you can switch 

between cards by selecting the desired card in the RAID Groups Window. 

When a controller is selected, the RAID Groups currently defined on that controller are also 

shown in the RAID Groups Window.  Selecting a specific RAID Group will highlight the 

segments associated with that volume in the Device Configuration Window. 

The Device Configuration window identifies all physical drives and their partitions. 
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Throughout the Manager, different colors are used to indicate the status of the components. 

The meanings of the colors are: 

COLOR STATUS 

Green Good.  The component and all subcomponents are okay. 

Yellow Warning.  This component or at least one subcomponent 

has become degraded and requires service. 

Red Failed.  This component or at least one subcomponent 

has failed. 

Grey Unused. 

4.2 CREATING RAID GROUPS 

To begin creating a new RAID Group, select “Create RAID Group” from the RAID Group menu 

or right click on a controller in the RAID Groups window and select “Create RAID Group” from 

the pop-up menu.  This will cause the Create RAID Group dialog to appear. 

 

Note: The term “right-click” refers to using the secondary button on your mouse to 

perform the indicated operation. On a Windows system, use the mouse button that 

you have defined to be the secondary button (by default, that button is on the right 

side of the mouse, unless you have reconfigured the primary and secondary mouse 

buttons using Control Panel > Mouse). On a Macintosh system, press and hold the 

Command (Apple) key and click the mouse. 

 

4.2.1  CONTIGUOUS RAID GROUPS 

Contiguous RAID Groups allow the user to select a segment of disk drive or a disk drive. 

Select the disk and enter the desired values and press Create to create the RAID Group 

(Example below). 
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4.2.2  CONCATENATED RAID GROUPS 

Concatenated RAID Groups allow the user to select different sized segments for each 

member of the volume.  For Concatenated volumes only, a dialog box will appear allowing the 

user to select the individual segment sizes from each disk.  Enter the desired values and 

press Create to create the RAID Group (Example below). 

     

4.2.3  STRIPED RAID GROUPS 

Striped RAID Groups allow the user to select minimum of 2 or more disks for each member of 

the volume. Enter the desired values and press Create to create the RAID Group (Example 

below). 
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4.2.4  MIRRORED RAID GROUPS 

Mirrored RAID Groups allow the user to select 2 disks for each member of the volume. Enter 

the desired values and press Create to create the RAID Group (Example below). 

   

4.2.5  MIRRORED STRIPED RAID GROUPS 

Mirrored Striped RAID Groups allow the user to select minimum of 4 disks for each member 

of the volume. Enter the desired values and press Create to create the RAID Group (Example 

below). 
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4.2.6  PARITY RAID GROUPS 

Parity RAID Groups allow the user to select minimum of 3 or more disks for each member of 

the volume. Enter the desired values and press Create to create the RAID Group (Example 

below). 
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4.2.7  RAID GROUPS OVERVIEW 

RAID Groups allow Enter values in all fields and click Create to create the RAID Group.  

FIELD DEFINITION  

RAID Group 

Label 

Enter an identifiable name for the RAID group. This value can be any string (up to 8 

characters including blank spaces) to help users identify this volume. 

RAID Group 
Select a Group ID from the available ID list. The maximum number of RAID Groups 

per controller is 8, so Group ID can be any number between 0 and 7, inclusive. 

Configuration 

Select which RAID level is to be used to configure these members:  

• Contiguous (for virtual disk).  

• Concatenated (for multiple concatenated segments).  

• Striped (for RAID 0)  

• Mirrored (for RAID 1)  

• Mirrored Striped (for RAID 10)  

• Parity RAID (for RAID 5)   

Capacity 

Select a value to define the total usable capacity of the RAID Group or manually 

enter the volume size in gigabytes (GB). Selecting MAX will create the largest RAID 

set possible with the drive(s) selected. 

Chunk Size 

Select a value to define the chunk size (stripe size) for performance tuning. In 

general, large stripe sizes are best for large files that are accessed sequentially (for 

example, media streaming files) and smaller sizes are better for randomly accessed 

data like databases. This parameter is not used for Contiguous (JBOD), 

Concatenated, and Mirrored configurations.  

Rebuild 

Priority 

Select a value to identify how quickly the controller should rebuild data on a disk 

after a hardware failure. A value of 1 is the lowest priority and will take the longest 

to rebuild. A value of 10 is the highest priority and will rebuild the fastest, but may 

require more CPU resources, which might affect the computer’s performance. This 

parameter is not used for Contiguous (JBOD), Concatenated, and Striped 

configurations.  
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Check 

Pointing  

Click the On or Off button to enable or disable the Check Pointing feature. When 

Check Pointing is enabled, restoring data is very fast after an unexpected power 

loss, although normal performance may be slightly reduced. When Check Pointing 

is disabled, normal performance is improved, but restores can take a long time to 

complete. This selection is only available when the selected RAID configuration is 

Mirrored, Mirrored Striped or Parity RAID, and the “Advanced RAID Features” 

checkbox in the Configuration/Advanced Options dialog is checked.  

Parity  

Click the On or Off button to enable or disable the ability to return “dirty” data after 

an unexpected power loss and all of the data could not be written to disk, rather 

than taking the volume off-line. This selection is only available when the selected 

RAID configuration is Parity RAID and the “Advanced RAID Features” checkbox in 

the Configuration/Advanced Options dialog is checked.  

Devices  

Select the RAID member devices from the available device segment grid. Up to five 

members can be selected for Contiguous, Concatenated, Mirrored, Striped or 

Parity RAID modes (although Mirrored RAID Groups will typically contain only two 

members). Exactly four members must be selected for Mirrored Striped mode.  

 

RAID Level Min # of 

Disks 

0 2 

1 2 

5 3* 

10 4* 

Contiguous 1 

Concatenated 1 

Once all parameters have been selected, select “Create” to create the RAID Group.  When 

finished, press Cancel to exit the Create RAID Group Dialog. 

                                                           
* For 3132, this requires the use of a Port Multiplier device to access more than one disk per SATA channel. 
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4.3 ADDITIONAL MENU COMMANDS 

 

The Main menu commands are shown below 

File Device RAID Group Window Legacy Support Help 

Configuratio

n… 

Create Spare Create RAID Group Task 

Manager 

Create Legacy RAID Group Help 

Topics 

Exit Delete Spare Rebuild RAID 

Group 

Event Log Rebuild Legacy RAID 

Group 

About 

 Delete 

Member 

Delete RAID Group Resources Delete Legacy RAID Group  

 Delete Orphan Bring RAID Group 

Online 

 Convert Legacy RAID 

Group 

 

 Make Pass-

Thru 

RAID Group 

Summary 

 Bring Legacy RAID Group 

Online 

 

 Device 

Summary 

  Create Legacy Spare  

    Delete Legacy Spare  

    Convert Legacy Spare  

The commands are documented on the pages that follow. 
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4.3.1  CONFIGURATION 

SATARAID5 configuration options include customization of the settings for Log File, Popup, 

and Advanced Options.  This command displays a dialog box to let user set different 

configurations for SATARAID5 with the following three tabs: 

Log File Tab 

The Log File tab allows you to define the location and name of the log file. The log file is used 

to store event information received from all Silicon Image RAID drivers. The log file is a text 

file and can be viewed with any text viewer (such as “Notepad” on Windows platforms) or 

with the Event Log window of the SATARAID5 Manager. Use the Log File tab to set the 

location and the desired filename for the log file. 

 

To specify whether the Log File is generated, click on either the Disabled or Enabled radio 

button. If Log File generation is enabled, you can click the Browse button to specify the file 
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name and location of the Log File. You can also use the Purge button to delete the contents 

of the Log File.  
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Popup Tab 

SATARAID5 can be configured to notify the user of events using messages in popup windows. 

Use the slider control to set the event level for popups to occur: 

- Information Level - The following events will trigger a popup window: 

 Informational 

 Warnings 

 Errors 

- Warning  Level - The following events will trigger a popup window:  

 Warnings 

 Errors 

- Error Level  - The following events will trigger a popup window: 

 Errors 

- Disable All - No events will trigger a popup window. 
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Advanced Options 

The Advanced Options tab is used to control advanced features of the RAID driver. By default, 

all these advanced options are disabled.  

 

The Advanced Options tab allows you to enable the following advanced features. 

FEATURE EXPLANATION 

Legacy (Bootable) 

Support  

When this feature is selected, Legacy Support menu will be available in 

the menu bar. Enables the Legacy Support menu to support RAID 

functions for legacy RAID groups (available on Windows platforms 

only). See Legacy Support menu options.  

Delete Member 

Support  

When this feature is selected, Delete Member menu item will be 

available under the Device menu. Enables the Delete Member option 

on the Device menu to delete a member from RAID 1 (Mirrored), RAID 5 

(Parity RAID), and RAID 10 (Striped and Mirrored) groups. See Delete 

Member menu option.  
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Advanced RAID 

Features  

When this feature is selected and user selects to create RAID group, if 

the RAID group to be created is fault tolerance group (RAID 1, RAID 5, 

or RAID 10), user will be able to select Improper Shutdown Policy in 

the Create RAID Group dialog box. Enables the selection of an 

Improper Shutdown Policy (including Check-Pointing and Dirty Parity 

handling) in the Create RAID Group dialog box when the selected RAID 

Group type is a fault-tolerant configuration (Mirrored, Mirrored/Striped 

and Parity RAID). This feature is not supported for Legacy RAID 

groups.  

Resources Info 

Support  

When this feature is selected, Resources menu item will be available 

under the Window menu. Enables the Resources option on the 

Window menu for debugging purposes. See Resources menu option.  

4.3.2  EXIT 

This command terminates the SATARAID5 program. 
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4.3.3  CREATE SPARE 

This command displays a dialog box to let user create spare drive, user needs to select the 

following parameters: 

PARAMETER  DESCRIPTION  

Spare Type  

Choose one of:  

 • Global - If the spare drive is for all RAID groups in the system. 

 • Dedicated - If the spare drive is dedicated to the specified RAID group. 

Capacity  
If you select Global for the Spare Type, current options from a list of capacity 

are from 128 MB to 100 GB, HALF and MAX. 

RAID Group  
If you select Dedicated for the Spare Type, please selected RAID group to 

which this spare drive is dedicated.  

Device 

Segment  
Select one device segment from the available spare type only.  

 

            

4.3.4  DELETE SPARE 

This menu option displays a dialog box to select (highlight) one or more spare drives to delete.  
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4.3.5  DELETE MEMBER 

This menu option displays a dialog box to select (highlight) RAID group members to delete. 

Because RAID 0 is not fault tolerant, RAID 0 members are not shown in the list.  

Note: Deleting members will demote the RAID group to a non-fault-tolerant RAID group.  

 

4.3.6  DELETE ORPHAN 

This menu option displays a dialog box to select (highlight) orphan segments to delete. An 

orphan segment is part of a RAID group that cannot access other segments within the same 
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RAID group. When a member of a RAID group fails in a severe manner (such as a loss of 

power or a complete hard disk failure), it becomes an orphan.  

This command displays the Delete Orphan Segment window to show all orphan segments 

and allow user to delete selected orphan segments. 

 

4.3.7  MAKE PASS-THRU 

This menu option is not available in this product.  

4.3.8  DEVICE SUMMARY 

This command displays the Segment Summary window to show all physical devices’ 

segments. 

 

The Segment Summary window has its own menu bar.  All options available via the menu bar 

are shown below 
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File Options

Exit Sorting

… 

 Fields…

Exit 

This command closes the Task Summary window. 

Sorting 

This command sorts the rows based on the selected field.  

 

Fields 

This command displays a dialog box to let user choose which fields will be shown in the 

Segment Summary window. 

 

4.3.9  CREATE RAID GROUP 

This command displays a dialog box to let user verify a raid type than display Create RAID 

Group dialog box. 
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4.3.10 REBUILD RAID GROUP 

This command displays a dialog box to let user choose a replacement segment to rebuild a 

non-fault tolerant RAID group. 
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4.3.11 DELETE RAID GROUP 

This command displays a dialog box to let user choose RAID groups to delete. 

 

4.3.12 BRING RAID GROUP ONLINE 

This menu option is not available in this product.  

4.3.13 RAID GROUP SUMMARY 

This command displays a dialog box to show all RAID groups’ group ID, configuration, and 

status. 
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The RAID Group Summary window has its own menu bar. All options available via the menu 

bar are shown below. 

File Options

Exit Sorting

… 

 Fields…

Exit 

This command closes the RAID Group Summary window. 

Sorting 

This command displays a dialog box to let user choose up to 3 items to sort RAID group 

items in the RAID Group list. 

 

 

Fields 

This command displays a dialog box to let user choose which fields will be shown in the 

RAID Group Summary window. 
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4.3.14 TASK MANAGER 

This command displays the Task Manager window. The Task Manager window lists all RAID 

and disk management tasks that have been started and/or done. This window provides user 

the ability to schedule any RAID and disk management operations including RAID group 

creation, rebuild, and test. 

 

The Task Manager window has it’s own menu bar.  All options available via the menu bar are 

shown below 

File Options Task 

Open

… 

Sorting

… 

Modify… 

Save… Fields… Suspend

… 
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Print…  Resume

… 

Exit  Cancel… 

  Delete… 

Open 

  This option will be available in future revisions. 

Save 

  This option will be available in future revisions. 

Print 

  This option will be available in future revisions. 

Exit 

This command closes the Task Summary window. 

Sorting 

This command displays a dialog box to let user choose up to 3 items to sort task items 

in the task list. 

 

Fields 

This command displays a dialog box to let user choose which fields will be shown in the 

task list. 
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  Modify 

This command allows user to modify parameters of the selected task items.  The 

following is an example of changing rebuild priority for a rebuild task. 

 

Suspend 

This command allows user to suspend the selected task items. 

Resume 

This command allows user to resume the suspended task items. 

Cancel 

This command allows user to cancel the selected task items. 

 

Delete 
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This command displays a dialog box to let user delete the selected task items from the 

task list in Task Summary window.  The following dialog box will pop up to get 

confirmation from the user. 

 

4.3.15 EVENT LOG 

This command displays the Event Log window.  The Event Log window displays SATA 

device-related events that occur while SATARAID5 is running.  

 

The Event Log window has it’s own menu bar.  All options available via the menu bar are 

shown below 

File Options

Exit Sorting

… 

 Fields…

Exit 

This command closes the Event Log window. 

Sorting 

This command displays a dialog box to let user choose up to 3 items to sort event items 

in the event log. 
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Fields 

This command displays a dialog box to let user choose which fields will be shown in the event 

log. 

 

4.3.16 RESOURCES 

This command displays the Resource Information window. This feature is for debugging 

purpose only. 

 



4 Bay SATA to eSATA 3.5” HDD RAID Storage System RSV-S4-X                                              User Manual 
 
 

 110

The Event Log window has it’s own menu bar.  All options available via the menu bar are 

shown below 

File Display 

Exit Suspend   

Alt+S 

 Resume   Alt+R 

Exit 

This command closes the Resources window. 

Suspend 

This command is to suspend the resources informantion. 

Fields 

This command is to resume the resources informantion. 

4.3.17 CREATE LEGACY RAID GROUP 

This menu option is not available in this product.  

4.3.18 HELP TOPICS 

This command opens an interactive help dialog using the standard Windows help interface. 

This option will be available in future revisions. 

4.3.19 ABOUT 

This command displays a dialog box with more information about the SATARAID5 program, 

including the revision level. 
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Thank you for purchasing a quality Rosewill Product. 

Please register your product at : www.rosewill.com for complete warranty information and future support for your product. 

 

 


